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1. About this document
The User Guide contains step-by-step instructions and reference information for using Positive
Technologies Industrial Security Incident Manager freeView Sensor (PT ISIM freeView Sensor). The
guide describes main and advanced features of PT ISIM freeView Sensor and explains how to
configure functions to implement specific tasks.

The guide is intended for specialists who use PT ISIM freeView Sensor in their work.

In this section
Document conventions (see Section 1.1)

Other sources of information about product (see Section 1.2)

1.1. Document conventions
This guide uses the following document conventions.

Table 1. Document conventions

Sample text Description

Warning. Disabling the module decreases the
level of network security

Warnings. Contain information about actions
or events with potentially negative conse-
quences

Note. You can create additional reports Notes. Contain tips, descriptions of important
special cases, and additional or reference in-
formation that might be useful

► To open the file: The beginning of instructions is marked with a
specific symbol

Click OK Names of interface elements (for example,
buttons, text boxes, and menu items) are high-
lighted in bold

Run the Stop-Service command Command-line text and code examples that
need to be entered using the keyboard are
highlighted in a special font. File names and
paths to files and folders are also indicated in
a special font

CTRL+ALT+DELETE Key combination. To activate the combination,
the keys need to be pressed at the same time

<Application name> Variables are enclosed in angle brackets

About this document
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1.2. Other sources of information about product
You can find additional information about PT ISIM freeView Sensor on www.isim.pt. The portal
contains answers to frequently asked questions.

If you cannot find the necessary information or a solution to your problem, you can email your
question to us at ptisim@ptsecurity.com or ask it in our Telegram group at t.me/isimpt.

Positive Technologies does not undertake to provide technical support to PT ISIM freeView Sensor
users. Official technical support is provided to users of the commercial editions of the product
(netView and proView).

About this document
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2. About PT ISIM freeView Sensor
Positive Technologies Industrial Security Incident Manager (PT ISIM) is a software and hardware
appliance that ensures cybersecurity of industrial control systems (ICSs).

PT ISIM freeView Sensor is a free version of PT ISIM supplied as a virtual machine image. PT ISIM
freeView Sensor has fewer functions and incident detection rules. Positive Technologies does not
provide regular updates and technical support for PT ISIM freeView Sensor.

Table 2. PT ISIM View Sensor functions

Function freeView
Sensor

netView
Sensor

proView
Sensor

Automatic mapping of nodes and their network interaction,
real-time monitoring of connections to the network

  

Automatic authorization of all new nodes and all new con-
nections (learning mode)

  

Support for industrial protocols   

Tools for filtering and searching for events and incidents   

Visualization of incidents on the network diagram   

Viewing the network diagram, node and connection param-
eters for a selected point in time (history mode)

  

Generation of a list of authorized connections and nodes   

Export of a list of events, incidents, and nodes as a CSV file   

Storage and export of a copy of traffic related to a time
range, event, or incident

  

User role model, activity history   

Sending notifications of incidents to a syslog server   

Sending email notifications of incidents   

Generation of statistical reports   

Integration with PT ISIM Overview Center   

Monitoring of technological parameters   

Processing of events taking account of the process logic   

Tool for creating custom incident detection rules   

Tool for creating a process mimic diagram   

Visualization of incidents on a mimic diagram   

About PT ISIM freeView Sensor
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3. What's new in version 1.6
This section gives an overview of new features and improvements in PT ISIM freeView Sensor 1.6.

History mode
You can now monitor the history of changes in the network diagram, node and connection
parameters. For this, PT ISIM freeView Sensor now includes history mode (see Section 12.7), which
allows viewing topology for a selected point in time.

Support for protocols of Emerson and Yokogawa equipment
PT ISIM freeView Sensor 1.6 can detect incidents in traffic received from Emerson and Yokogawa
equipment. For this, analysis (see Section 4.2) of the DeltaV Commisioner, DeltaV Firmware
Upgrade, and Vnet/IP protocols is introduced. PT ISIM freeView Sensor contains a set of incident
detection rules for each of these protocols.

New recognized protocols
The list of recognized protocols (see Section 4.2.2) now also includes RIP, BGP, SSDP, DICOM,
NTP, HART-IP, BACnet, LDAP, CLDAP, Kerberos, CPHA, CUPS, RADIUS, DIAMETER, PTP, MQTT,
CoAP, S7CommPlus, FTE, Fieldbus. Recognized protocols do not have specific incident detection
rules in PT ISIM freeView Sensor, but each instance of their use is recorded as an "Unauthorized
<protocol name> connection" incident.

Free license issue fixed
A free license previously limited the use of PT ISIM freeView Sensor to three months. This issue is
now fixed, and you can use the new version of the product for an unlimited period of time.

Upgrade to Debian 9
The product operating system has been upgraded from Debian 8 to Debian 9. The OVA image of
PT ISIM freeView Sensor 1.6 is supplied with Debian 9.8 AMD64.

What's new in version 1.6
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4. PT ISIM freeView Sensor operating principle
This section contains basic information about the operating principle of PT ISIM freeView Sensor.

In this section
Traffic processing algorithm (see Section 4.1)

Supported protocols (see Section 4.2)

4.1. Traffic processing algorithm
PT ISIM freeView Sensor analyzes network traffic and detects incidents based on correlation and
modeling rules.

Traffic is processed by PT ISIM freeView Sensor in the following several stages:

1. Collection. Traffic is captured from a SPAN port of a switch and messages of common network
and industrial protocols (see Section 4.2) are analyzed to detect information about information
security events. Collected information is sent for normalization.

2. Normalization. Data is extracted from attributes of records, which may be of various formats,
and reduced to a unified format of normalized messages. A normalized message has a set
number of fields with certain permitted values for each field. Such a message format allows
precise identification of basic parameters of an event and its relation to a node or device, as
well as further analysis of the event based on specific field values.

3. Filtering. Messages irrelevant to information security are deleted.

4. Correlation. A stream of events is matched against a specific rule. A triggered correlation rule
produces a correlated message.

5. Modeling. The computer network is mapped to obtain up-to-date information about its real
composition and interaction between nodes.

6. Creation of incidents. Based on rules that take account of the current data of a model and
correlated messages, PT ISIM freeView Sensor can classify an event as an incident.

After traffic processing is completed, events and incidents are recorded in PT ISIM freeView
Sensor.

4.2. Supported protocols
PT ISIM freeView Sensor can process a wide range of protocols, both common network protocols
and protocols specific to industrial networks.

PT ISIM freeView Sensor operating principle
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Depending on the level of processing, protocols can be divided into two types:

– Analyzed protocols. PT ISIM freeView Sensor analyzes such protocols deeply enough to
obtain the required message attributes and their values from traffic and use them during
correlation. As a rule, several types of incidents correspond to each such protocol.

– Recognized protocols. PT ISIM freeView Sensor records each case when such protocols are
used in the network but does not distinguish between incident types. As a rule, these are
application-layer protocols, and their use is not acceptable in ICS networks.

In this section
Analyzed protocols (see Section 4.2.1)

Recognized protocols (see Section 4.2.2)

4.2.1. Analyzed protocols
This section contains a list of protocols and the degree of their analysis by PT ISIM freeView
Sensor.

Table 3. Supported protocols

Protocol Standard Description, degree of analysis

IEC
60870-5-104

IEC 60870-5-104 The most significant messages are decoded with their
values and have their own types of events (Command,
Measurement, Monitoring). These categories include
events of the following types: single- and double-point
information with and without a time tag, single com-
mand, double command, all kinds of measurement,
clock synchronization. Type numbers: 1–4, 9–4, 30, 31,
34–36, 45, 46, 103. The remaining types of messages
are classified into general groups: Process manage-
ment, Process monitoring, General system monitoring,
File transfer, General system management, Parameters

IEC 61850
MMS

IEC 61850-8-1 Read and write service acknowledgements, static re-
ports (without analysis of data set values), file trans-
fers, error messages (Cancel, Reject, Error) are classi-
fied as separate types of events

Modbus TCP MODBUS Applica-
tion Protocol Spec-
ification V1.1b3

All messages with process signals (register and dis-
crete data read/write) are analyzed. Encapsulated
transport, FIFO, file record read, diagnostic information,
message log data are identified and displayed in a sum-
marized format

Profinet DCP IEC 61158-6-10 The following events are registered: Device description
request/response, setting of parameter values

PT ISIM freeView Sensor operating principle
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Protocol Standard Description, degree of analysis

Siemens S7
(STEP7)

Communication
protocol standard
of the Siemens
SIMATIC
S7-300/400 series
communication
modules

Messages with process signals (regular read, read by
subscription, write) are analyzed. The full process ad-
dress (block type, block number, byte and bit number)
and an undecoded value are displayed. Service packets
(connection setup, simple confirmation, error, block
loading/unloading, time synchronization, CPU informa-
tion, etc.) are captured. Commands to change the PLC
status (start, stop) and indication of status changes are
considered separately. Both the TCP/IP variant of the
protocol and the ISO variant built over Ethernet are pro-
cessed

CIP (EtherNet/
IP)

The CIP Networks
Library Volume 1 -
Common Industrial
Protocol (CIP™)
(Edition 3.3),

The CIP Networks
Library Volume 2 -
EtherNet/IP Adap-
tation of CIP (Edi-
tion 1.4)

Messages of all known valid services are classified as
separate types of events. Messages of all unknown
valid services are classified as a separate type of event.
Messages of all invalid services are classified as a sep-
arate type of event. Each event contains a destination
address to identify the type of operation (restart,
change of IP/port parameters, time synchronization,
configuration reset, change of modes), and a return
code for error detection (request for a non-existent pa-
rameter, connection failures, unknown destination ad-
dress). Event data set values are not decoded. Currently
processed for TCP packets only

Spabus SPA-Bus Commu-
nication Protocol
V2.5

Events of all basic types (R, D, W, A, N) are identified.
Channel and device numbers are displayed. For mes-
sages with data (read and write), the address and value
are identified. For messages with errors, the message
category is displayed. Settings/configuration change in-
cidents and unauthorized impact are identified

OPC DA OLE for Process
Control Data Ac-
cess Automation
Interface Standard
v.2.0

Authentication, tag tree browsing, and tag read/write
events are identified. For authentication events, the
username and server hostname are specified

FTP RFC 959 A standard protocol for transferring files over TCP net-
works.

Classified events include successful authentication,
password bruteforcing attempts, requests/responses,
data transfers, attempts to inject code into requests

Telnet RFC 854 A standard protocol for implementing a text interface
over a network.

Classified events include password input, unsuccessful
authentication attempts, text data transfers

PT ISIM freeView Sensor operating principle
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Protocol Standard Description, degree of analysis

DHCP RFC 2131 A standard protocol for retrieving operation parameters
in a TCP/IP network.

Classified events include DHCPREQUEST, DHCPOFFER,
DHCPACK, DHCPNAK

ARP RFC 826 A standard protocol for resolving MAC addresses
based on IP addresses.

Classified events include Request, Response, Host
changed MAC address, New node appeared in network

TFTP RFC 1350 A simplified file transfer protocol.

Classified events include Response, File transfer

DNS RFC 1034, RFC
1035

A protocol for retrieving information about domains

Classified events include Request and Response

ICMP RFC 792 A service TCP/IP stack protocol

Classified events include Echo request

HTTP RFC 1945, RFC
2616, RFC 7231

An application-level data transfer protocol.

Classified events include Simple authentication, Data
transfer

SNMP RFC 1155, RFC
1212, RFC 1213,
RFC 1157, RFC
3411

A protocol for managing devices in IP networks.

Classified events include Value request, Value setting,
Asynchronous notifications

SSH RFC 4251 A protocol for remote management via a tunneled TCP
connection.

Two variants of data transfer are classified: with weak
and strong encryption

DeltaV Com-
misioner

— A management and interaction protocol for the DeltaV
management system equipment produced by Emerson

DeltaV
Firmware Up-
grade

— A protocol for updating the firmware of the DeltaV PLC
produced by Emerson.

Vnet/IP IEC PAS 62405, IEC
61784-1, IEC
61784-2, IEC
61784-3-17, IEC
61784-4-17, IEC
61784-5-17, IEC
61784-6-17

A network exchange protocol for Yokogawa equipment

PT ISIM freeView Sensor operating principle
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4.2.2. Recognized protocols
A recognized protocol is a protocol that does not have specific types of incidents in PT ISIM
freeView Sensor. For each recognized, as well as for each analyzed protocol, there is a uniform
"Unauthorized <protocol name> connection" incident.

The following protocols are recognized: BACnet, BGP, Bitcoin, BitTorrent, CLDAP, CoAP, CPHA,
CUPS, DIAMETER, DICOM, DNP3, Fieldbus, FTE, GOOSE, HART-IP, IMAP, IRC, JSON-RPC, Kerberos,
LDAP, LLMNR, MQTT, NFS, NTP, NTP, POP3, PTP, RADIUS, RAdmin, RDP, RFB, RIP, RTSP,
S7CommPlus, SMB, SMTP, SOCKS5, SSDP, Syslog, Zabbix.

PT ISIM freeView Sensor operating principle
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5. Requirements for OVA image import

OVA image configurations
The supplied OVA image of a virtual machine with PT ISIM freeView Sensor runs on the Debian 9.8
AMD64 operating system. The OVA image includes the following virtual machine configurations:

1. "2 CPUs and 6144 MB RAM. Non-production. For evaluation only", which is a minimum
configuration for evaluation and testing purposes.

2. "4 CPUs and 8192 MB RAM. Acceptable-performance configuration", which is an acceptable
configuration for analyzing traffic at a rate of up to 60 Mbps.

3. "8 CPUs and 16384 MB RAM. Normal-performance configuration", which is a recommended
configuration for analyzing traffic at a rate of up to 100 Mbps.

Supported hypervisors
You can use the following hypervisors to import the OVA image:

– VMware Workstation 14.1.5, 15.0.0, 15.0.2

– VMware vSphere 6.0.0, 6.5.0, 6.7.0

– Oracle VM VirtualBox 5.1.38, 5.2.26, 6.0.4

You can select a configuration only in VMware Workstation and VMware vSphere. If you import the
OVA image using Oracle VM VirtualBox, the recommended configuration is selected automatically.

Host machine requirements
The server on which you want to deploy the OVA image must be capable of allocating the virtual
machine resources sufficient at least for the minimum configuration. The virtual machine disk
space is limited to 300 GB.

When the virtual machine is started, its basic parameters are displayed in the command line
interface (amount of RAM, disk space, number of cores, and CPU frequency). If the virtual machine
parameters are lower than the minimum configuration of the image, a system incident is recorded
in PT ISIM freeView Sensor.

For PT ISIM freeView Sensor to operate, at least two network interfaces are required: a service
interface to provide access to the product via the web interface and over SSH, and an industrial
interface to receive a copy of traffic of the analyzed network (see Section 6). The industrial
interface must be included in the bond0 virtual interface and must operate in promiscuous mode.

It is recommended that you use Google Chrome 65 or later or Mozilla Firefox 58 or later to access
the web interface of the product.

Requirements for OVA image import
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6. Configuring traffic mirroring
For PT ISIM freeView Sensor to operate, at least two network interfaces are required: a service
interface to provide access to the product via the web interface and over SSH, and an industrial
interface to receive a copy of traffic of the analyzed network (see Section 5). To enable the
industrial interface to receive a copy of traffic, you must configure traffic mirroring. This interface is
then included in the bond0 virtual interface (see Section 7.4).

The simplest option is to configure mirroring from one port to another port of a switch. Depending
on the manufacturer, this approach is called Port Mirroring or SPAN (Switched Port Analyzer).

If you want to monitor traffic from all ports of a certain virtual local area network or if several
switches and VLANs are used in the analyzed network, it is more convenient to use the RSPAN
(Remote SPAN) technology that allows combining the necessary switches and VLANs into a
special virtual network for remote mirroring (RSPAN VLAN).

If you use the VMware vCenter server to manage VMware vSphere virtual machines, you can use
the vSphere Distributed Switch virtual switch to match an RSPAN VLAN to a virtual machine
interface.

Warning. PT ISIM freeView Sensor is designed to manage mirrored traffic. If Windows is used
as a host operating system, replaying PCAP files on an interface included in bond0 of the
PT ISIM freeView Sensor guest machine using the tcpreplay utility may cause such an
interface to fail.

In this section
Configuring port mirroring (see Section 6.1)

Configuring remote mirroring (RSPAN) (see Section 6.2)

Configuring mirroring using vSphere Distributed Switch (see Section 6.3)

6.1. Configuring port mirroring
This section contains instructions on how to configure mirroring using Cisco and Hirschmann
switches as examples.

The switch port that receives mirrored traffic must be connected to the network interface of the
server with PT ISIM freeView Sensor installed.

This interface must differ from the service interface used to access the product via the web
interface or over SSH. You can configure network interfaces on a virtual machine after it is started,
in the special interface configuration window (see Section 7.4).

In this section
Configuring mirroring on Cisco switch (see Section 6.1.1)

Configuring mirroring on Hirschmann switch (see Section 6.1.2)

Configuring traffic mirroring
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6.1.1. Configuring mirroring on Cisco switch
► To configure mirroring on a Cisco switch,

Run the commands:
sw# conf t
sw(config)# monitor session 1 source interface <source_interface>
sw(config)# monitor session 1 destination interface <destination_interface>

where:

<source_interface> is the source port from which traffic must be mirrored.

If traffic must be mirrored from a certain VLAN, you can specify source vlan <vlan_id>
instead of source interface.

<destination_interface> is the port to which traffic must be mirrored.

For example:
sw(config)# monitor session 1 source interface Gi0/1
sw(config)# monitor session 1 destination interface Gi0/2

6.1.2. Configuring mirroring on Hirschmann switch
In the following instructions, Hirschmann RS40-0009CCCCSDAP Rail Switch is used as an example.

Note. The switch firmware version must be 7.0.00 or later.

► To configure mirroring on a Hirschmann switch:

1. In the web interface of the switch, go to Diagnostics → Port Mirroring N:1.

2. Under Operation, click On.

3. In the Destination port drop-down list, select the port to which traffic must be mirrored.

4. In the Source port column, select the Rx and Tx check boxes next to the ports from which
traffic must be mirrored.

5. Click Set.

Configuring traffic mirroring

16



Figure 1. Configuring mirroring on a Hirschmann switch

6. Go to Basic Settings → Load/Save.

7. Under Save, click to Device.

8. Click Save.

6.2. Configuring remote mirroring (RSPAN)
► To configure mirroring using RSPAN:

1. Combine all switches from which traffic must be mirrored and transit switches on the way
to the switch that receives such traffic, into a virtual network for remote mirroring (RSPAN
VLAN):
sw# conf t
sw(config)# vlan <rspan_vlan_id>

For example:
sw(config)# vlan 400
sw(config)# remote-span

2. On each switch from which traffic must be mirrored, create a monitoring session:
sw(config)# monitor session 1 source vlan <source_vlan_id>
sw(config)# monitor session 1 destination remote vlan <rspan_vlan_id>

where:

<source_vlan_id> is the ID of the VLAN that carries the necessary industrial network
traffic. You can list several VLANs separating them with commas.

<rspan_vlan_id> is the ID of the RSPAN VLAN created in Step 1.

Configuring traffic mirroring
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For example:
sw(config)# monitor session 1 source vlan 10,20
sw(config)# monitor session 1 destination remote vlan 400

3. On the switch that receives mirrored traffic, create a monitoring session:
sw(config)# monitor session 1 source vlan <rspan_vlan_id>
sw(config)# monitor session 1 destination interface <dest_interface>

where:

<rspan_vlan_id> is the ID of the RSPAN VLAN.

<destination_interface> is the port to which traffic must be mirrored.

For example:
sw(config)# monitor session 1 source vlan 100
sw(config)# monitor session 1 destination interface Gi0/Y

If you use the VMware vCenter server, you can configure mirroring using the vSphere Distributed
Switch (see Section 6.3) virtual switch instead of the last step.

The switch port that receives mirrored traffic must be connected to the network interface of the
server with PT ISIM freeView Sensor installed.

This interface must differ from the service interface used to access the product via the web
interface or over SSH. You can configure network interfaces on a virtual machine after it is started,
in the special interface configuration window (see Section 7.4).

6.3. Configuring mirroring using vSphere Distributed Switch
► To configure mirroring using vSphere Distributed Switch:

1. In vSphere vCenter, in the Networking tab, select the virtual distributed switch (vSphere
Distributed Switch).

2. In the Port mirroring tab, click New.

3. In the Select session type step, click Remote Mirroring Destination, and then click Next.

4. In the Edit properties step, in the Status drop-down list, click Enabled to activate mirroring
immediately after configuring is completed, and then click Next.

5. In the Select sources step, click ; in the VLAN ID box, enter the RSPAN VLAN (see Section
6.2) ID, and click Next.

6. In the Select destinations step, click , select the virtual machine with PT ISIM freeView
Sensor and the network interface on which mirrored traffic must be received, and click Next.

7. In the Ready to complete step, verify the mirroring settings and click Finish.

Configuring traffic mirroring
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Figure 2. Configuring mirroring using vSphere Distributed Switch

Configuring traffic mirroring
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7. Installing PT ISIM freeView Sensor
PT ISIM freeView Sensor is supplied as an OVA image of a virtual machine. To get a copy of
PT ISIM freeView Sensor, fill in the registration form on ptsecurity.com. A link to download the OVA
image and a license file to activate the product will be sent to your email address.

This section contains instructions on how to import the OVA image using the VMware Workstation,
VMware vSphere, and Oracle VM VirtualBox hypervisors and on how to set up network interfaces.

In this section
Installing PT ISIM freeView Sensor on VMware Workstation (see Section 7.1)

Installing PT ISIM freeView Sensor on VMware vSphere (see Section 7.2)

Installing PT ISIM freeView Sensor on Oracle VM VirtualBox (see Section 7.3)

Setting up PT ISIM freeView Sensor interfaces (see Section 7.4)

7.1. Installing PT ISIM freeView Sensor on VMware Workstation
► To install PT ISIM freeView Sensor on VMware Workstation:

1. Start VMware Workstation.

2. Click File → Open, and in the window that opens, select the file containing the PT ISIM
freeView Sensor OVA image.

3. In the Import Virtual Machine window:

• In the Name for the new virtual machine box, enter a name of the virtual machine.

• In the Storage path for the new virtual machine box, enter the path of the directory for the
virtual machine disk space.

Note that PT ISIM freeView Sensor may take up to 300 GB of disk space.
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Figure 3. Entering a virtual machine name and storage path

4. Click Next.

5. Select the 8 CPUs/16384 MB RAM virtual machine configuration.

Selecting a lower configuration is recommended only for testing and evaluation purposes.

Figure 4. Selecting a virtual machine configuration
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Note. Selecting a virtual machine configuration is available only if VMware Workstation 14
or later is used.

6. Click Import.

7. If the "The import failed because <virtual machine name> did not pass OVF specification
conformance or virtual hardware compliance checks" message is displayed during import,
click Retry.

8. After the OVA image is imported, click Edit virtual machine settings, select the industrial
interface (Network adapter 2), and under Network connection, select Custom.

9. In the Custom: Specific virtual network list, select a virtual network name different from
VMnet0 (service interface network), and click OK.

10. Click Edit → Virtual Network Editor.

11. For the VMnet0 virtual network, select Bridged, and in the Bridged to list, select the name of
the network adapter corresponding to the service interface.

Note. If you are not an administrator of the host machine, you may have to click Change
Settings to configure these settings.

12. Click Add Network, in the Select a network to add list, select the name of the virtual network
set in Step 9, and click OK.

13. Select Bridged; in the Bridged to list, select the name of the network adapter that receives
mirrored traffic, and click OK.

By default, industrial network interfaces are configured to operate in promiscuous mode. If a
UNIX-like operating system is used as a host machine, you may have to change the device
access permissions (see instructions on the VMware Knowledge Base website).

PT ISIM freeView Sensor is now installed.

On the first run of the virtual machine, you will be prompted to set up network interfaces (see
Section 7.4).

Note. If a VMware Workstation version earlier than 14 is used, the maximum configuration of
the OVA image to import is selected automatically. If the host machine has fewer than 8 cores
and less than 16,384 MB of RAM, the virtual machine is not started. To start the virtual machine,
you can change the OVA image parameters in the Hardware section (for example, by reducing
the number of cores from 8 to 4). Lower parameters are recommended for evaluation purposes
only as they may impact product performance.

7.2. Installing PT ISIM freeView Sensor on VMware vSphere
► To install PT ISIM freeView Sensor on VMware vSphere:

1. Start VMware vSphere.

2. Click File → Deploy OVF Template.

3. In the window that opens, in the Deploy from a file or URL box, enter the path of the file
containing the PT ISIM freeView Sensor OVA image, and click Next.
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Figure 5. Selecting an OVA image

4. On the OVF Template Details page, click Next.

5. On the Name and Location page, in the Name box, enter a name of the virtual machine; in
the Inventory Location box, specify the location of the virtual machine in the VMware
environment, and click Next.

Figure 6. Entering a virtual machine name and location
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6. On the Deployment Configuration page, select the 8 CPUs and 16384 MB RAM
configuration.

7. On the Host / Cluster page, specify the host or cluster on which the virtual machine will run.

8. On the Resource Pool page, select a resource pool within the VMware cluster.

9. On the Storage page, specify a location for virtual machine data storage.

Note that PT ISIM freeView Sensor may take up to 300 GB of disk space.

10. On the Disk Format page, select Thin Provision (on-demand extension of available
capacity), and click Next.

Figure 7. Selecting a capacity extension option

11. On the Network Mapping page, match the network interfaces included in the OVA image
(Source Networks) to your networks:

• MGMT is a service interface providing users with access to the web interface of the
product and over SSH.

• SPAN is an interface mirroring industrial network traffic from a SPAN port.

Installing PT ISIM freeView Sensor

24



Figure 8. Matching network interfaces

12. On the Ready to Complete page, select the Power on after deployment check box and click
Finish.

PT ISIM freeView Sensor is now installed.

On the first run of the virtual machine, you will be prompted to set up network interfaces (see
Section 7.4).

7.3. Installing PT ISIM freeView Sensor on Oracle VM VirtualBox
► To install PT ISIM freeView Sensor on Oracle VM VirtualBox:

1. Start Oracle VM VirtualBox.

2. Click File → Import Appliance, and in the window that opens, select the file containing the
PT ISIM freeView Sensor OVA image.

The Import Virtual Appliance window opens.

3. In the Guest OS Type list, select Debian (64-bit).

4. In the Virtual Disk Image box, enter the path of the directory for the virtual machine disk
space.
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Note that PT ISIM freeView Sensor may take up to 300 GB of disk space.

Note. Since Oracle VM VirtualBox does not allow selecting a configuration of the OVA image
to import, the maximum configuration (see Section 5) is selected automatically. If the host
machine has fewer than 8 cores and less than 16,384 MB of RAM, it is recommended to
specify real values for the CPU and RAM parameters. Lowering parameters to the minimum
configuration is recommended only for evaluation and testing purposes as it may impact
product performance.

Figure 9. Checking the parameters of an image to import

5. Click Import.

6. After the OVA image is imported, go to Network.

7. In the Adapter 1 tab, in the Name list, select the name of the network adapter corresponding
to the service interface.

8. In the Adapter 2 tab, configure the industrial traffic mirroring interface:

• In the Name list, select the name of network adapter that receives mirrored traffic.

• In the Promiscuous Mode list, select Allow All to enable this interface to receive all
network packets regardless of the recipient's MAC address.

If you want to use one more interface for industrial traffic mirroring, configure the same
settings in the Adapter 3 tab.
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Figure 10. Configuring network interface promiscuous mode

PT ISIM freeView Sensor is now installed.

On the first run of the virtual machine, you will be prompted to set up network interfaces (see
Section 7.4).

7.4. Setting up PT ISIM freeView Sensor interfaces
By default, the following two network interfaces are set up on the supplied virtual machine:

– eth0, which is a service interface providing users with access to the web interface and over
SSH.

– eth1, which is an interface for mirroring industrial network traffic. The interface is included
in the bond0 virtual interface.

On the first run of the virtual machine, a network interface setup window is displayed. The IP
address of a service interface is displayed in the window title.

Figure 11. Selecting network interface configuration options
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If default interface configuration options are enough, you can skip interface setup by clicking No.

If you want to change the set or settings of interfaces (for example, add another network interface
to bond0), set up network interfaces.

► To set up network interfaces:

1. Click Yes.

This opens the Interface list window containing a list of network interfaces.

Figure 12. Selecting a network interface

2. Select the interface from which industrial network traffic is captured, and press ENTER.

The <Interface name> configuration window opens.

Figure 13. Setting up a network interface

3. Select Add to bond and press ENTER.
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4. Add all interfaces from which industrial network traffic must be captured to the bond virtual
interface.

5. If a static IP address is required for the eth0 service interface, click <Reconfigure with static
IP>.

The Static IP configuration for <interface name> window opens.

Figure 14. Configuring a service interface static IP address

6. Configure the static IP address of the service interface by filling in the address (static IP
address), netmask (subnet mask), and gateway (IP address of the default gateway) boxes,
click Ok, and press ENTER.

This opens the Interface list window containing a list of network interfaces.

7. Select Save and press ENTER.

PT ISIM freeView Sensor network interfaces are now set up.

You will be automatically logged in to the command-line interface of the PT ISIM freeView Sensor
server as a superuser (root), and the following information will be displayed: root user account
password, IP address of the service interface, and basic parameters of the system (amount of
RAM, disk space, number of cores, and CPU frequency).

Note. If you want to change the default password of the root account, you can run the isim
sshpass command.

Note. If network interfaces must be reconfigured after the product is installed, you can open the
interface configuration window by running the isim net command.

See also
Network interface setup errors (see Section 17.6)
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8. Getting started with PT ISIM freeView Sensor
This section contains instructions on how to perform PT ISIM freeView Sensor initial setup when
you first log in to the web interface, how to disable learning mode and check the product health.

In this section
Performing PT ISIM freeView Sensor initial setup (see Section 8.1)

Enabling and disabling learning mode (see Section 8.2)

Initial check of PT ISIM (see Section 8.3)

8.1. Performing PT ISIM freeView Sensor initial setup
Before you start using PT ISIM freeView Sensor, you must perform its initial setup: select a
language, set a password for logging in to the product, specify the name of the facility on which the
product is installed, and upload the license file that you received after registering on
ptsecurity.com.

► To perform PT ISIM freeView Sensor initial setup:

1. In the address bar of your browser, enter the IP address of the service interface (see Section
7.4).

When you first log in to the web interface, the Initial setup window opens.

2. In the System language drop-down list, select English or Russian as the web interface
language.

3. Set the account password.

4. In the Set the sensor name box, enter the name of the PT ISIM freeView Sensor instance or
the name of the facility on which the product is installed.
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Figure 15. PT ISIM Free View Server initial setup

5. Click Next.

The Register your copy window opens.

Getting started with PT ISIM freeView Sensor

31



Figure 16. Uploading the license file

6. Click Upload license file and select the received license file.

7. Click Finish.

Warning. Do not set back the system clock of the guest or host OS as this can make the
licensing mechanism to disable main functions of the product.

8.2. Enabling and disabling learning mode
When PT ISIM freeView Sensor discovers a previously unknown MAC or IP address in traffic,
"Unauthorized node" and "Unauthorized <protocol name> connection" incidents are created on the
Incidents page and a new unauthorized node appears on the Topology page.

Note. If learning mode (see Section 8.2) is turned on, such incidents are not created, and all
discovered nodes are considered authorized.

After installation PT ISIM freeView Sensor considers all nodes detected in the traffic as unknown
and thus unauthorized. This includes the nodes of the monitored network. After the product
installation, the learning mode is enabled, which means that PT ISIM freeView Sensor considers all
nodes and connections as trusted and does not record incidents of new nodes and connections. All
other incidents (attacks, warnings, and system incidents) are detected in the normal course.
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When learning mode is turned on, a corresponding message is displayed at the top of the Incidents
page. We recommend you to turn off the learning mode once PT ISIM freeView Sensor detected all
the nodes of your industrial network: detection of a new node or connection will be considered as
an incident.

► To turn off the learning mode,

On the Incidents page, click Turn learning mode off.

Figure 17. Disabling the learning mode

PT ISIM freeView Sensor will record incidents if detects any new node.

You can turn learning mode back on in the System preferences window that you can open by
clicking .

See also
Authorizing nodes (see Section 12.2)

Authorizing connections (see Section 12.3)

8.3. Initial check of PT ISIM
After installing the product and activating a license, you can check PT ISIM freeView Sensor to
make sure that it correctly detects events, incidents, and network nodes.

You can check PT ISIM freeView Sensor by sending a 100 bytes ICMP echo request to the
multicast address 224.0.0.42 from any network node, which is supposed to be monitored by
PT ISIM freeView Sensor.

► To perform an initial check of PT ISIM freeView Sensor,

Run the following command:

• In Windows:
ping -l 100 224.0.0.42

• In Unix-like system:
ping -c4 -s100 224.0.0.42
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The following data must be displayed in PT ISIM freeView Sensor:

– On the Incidents page—"PT ISIM test incident", "Unauthorized node", and "Unauthorized
connection" incidents.

– On the Events page—ICMP events "PT ISIM functional test".

– On the Topology page—a node with the source IP address of a server from which the
request was sent. As 224.0.0.42 is a multicast address, the destination node will not be
displayed.

Figure 18. PT ISIM test events
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9. Logging in to PT ISIM freeView Sensor
► To log in to PT ISIM freeView Sensor:

1. In the address bar of your browser, enter the IP address of the service interface (see Section
7.4).

When you first log in to the product, you must accept the license agreement, after which the
initial setup (see Section 8.1) window is displayed.

2. On the login page that opens, enter your login and password.

The default login is administrator. The password is set in the initial setup window when you
first log in to the web interface. You can also change your password later using the settings
menu .

3. Click Log in.

Figure 19. PT ISIM freeView Sensor login page

See also
Recovering password for logging in to web interface (see Section 17.2)
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10. PT ISIM freeView Sensor interface
Basic functions of PT ISIM freeView Sensor are available in the web interface of the product. After
you log in to the web interface, the Topology page is displayed by default. The main menu and
toolbar are displayed on all pages.

Main menu Toolbar

Figure 20. Topology page

You can use the main menu to switch between the basic pages of the web interface:

– Topology displays the network map, allows viewing detailed information about network
nodes and interactions between nodes, authorizing and deauthorizing nodes, grouping
nodes, authorizing connections.

– Incidents displays incidents, allows filtering them, changing their state, and starring them.

– Events displays events and the timeline. On the timeline, events are displayed in blue and
attacks are displayed in red.

The toolbar consists of the following control elements:

–  allows viewing the license agreement and product version number.

–  allows running product diagnostics, turning learning mode on or off, changing the web
interface language and sensor name.

–  allows changing the password and signing out of the product as the current user.

–  allows viewing the state of network interfaces.
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11. Managing incidents
This section contains basic information about incidents in PT ISIM freeView Sensor and provides
instructions on how to manage them.

In this section
About incidents (see Section 11.1)

Changing incident state (see Section 11.2)

Starring incidents (see Section 11.3)

Filtering incidents (see Section 11.4)

11.1. About incidents
An incident is an event or chain of events that may disrupt the integrity, confidentiality, or
availability of elements or resources of an analyzed network. PT ISIM freeView Sensor detects
incidents based on correlation and modeling rules.

Incidents are listed on the Incidents page. All newly detected incidents are "open".

Depending on impact and the attacker's potential targets, incidents are divided into the following
types: attacks, warnings, system incidents.

If certain incidents are of special interest and you want to view them as a separate list, you can star
such incidents.

The number of incidents of each type, state and of starred incidents is displayed in the filter panel
on the left side of the page.

Figure 21. Incident list

Managing incidents

37



Clicking an incident opens its card that allows viewing its detailed description and changing its
state.

Figure 22. Incident card

Clicking Events between nodes during incident opens the Events page with the following filter
applied: all events between the source node and the target node of the incident are displayed for 10
minutes before and 10 minutes after the incident detection time.

For suspended warnings, a timeline is displayed at the top of the card showing when such an
incident will be reopened.

Events that caused the incident are displayed under Event list in the lower part of the card.

11.2. Changing incident state
All new incidents are "open". Depending on impact and measures taken, you can change the state
of an incident: start processing, close, reopen it. You can suspend warnings for two weeks, one
month, or three months. The state of an incident is displayed in the list of incidents, with closed
incidents in dimmed strikethrough type.

► To change the state of an incident:

1. On the Incidents page, select an incident.

2. In the incident card, in the Current state drop-down list, select a state: open, in progress, or
closed.

The state of the incident is now changed.
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► To change the state of several incidents simultaneously:

1. On the Incidents page, select incidents using check boxes to the left of the incident
detection date.

2. In the window that opens, in the State drop-down list, select a state: open, in progress, or
closed.

Note. For warnings, you can select suspended and specify the period for which you want to
suspend the incident (2 weeks, month, 3 months). After this period expires, the state of the
incident is changed back to open. The time left before the warning is opened is displayed in
the incident card.

The state of the incidents is now changed.

The following types of incidents are reopened automatically:

– "Unauthorized connection", if PT ISIM freeView Sensor detects a new unauthorized
connection between the same nodes over the same protocol as in a closed incident. If such
a connection is acceptable, authorize it (see Section 12.3) to prevent the incident from
reopening.

– Warnings, if the period for which they were suspended expires.

In both cases, the timestamp of an incident is updated.

11.3. Starring incidents
If certain incidents are of special interest and you want to view them as a separate list, you can star
such incidents.

You can view starred incidents as a separate list by clicking Starred in the filter panel.

► To star an incident,

On the Incidents page, to the right of the incident, click ★.

The incident is now starred.

► To unstar an incident,

On the Incidents page, to the right of the incident, click .

11.4. Filtering incidents
By default, the Incidents page displays all detected incidents. You can use the following tools to
change the list of displayed incidents:

– Filter panel, for filtering incidents by type, state and displaying only starred incidents

– Search box, by specifying an incident name, the MAC or IP address of an involved node

Filtering methods cannot be combined: entering a value in the search box resets filtering by state,
type, and starred status.

Managing incidents

39



► To filter incidents by type, state or view only starred incidents,

On the Incidents page, in the filter panel, select a filter criterion.

You can select several filter criteria simultaneously to combine them.

Figure 23. Filtering starred incidents

You can click All to clear the criteria selected in the filter panel and display all incidents.

► To filter incidents by name, by MAC or IP address of an involved node,

In the search box, enter the incident name, MAC or IP address of the node.

Figure 24. Filtering incidents for which the HTTP protocol is specified in the name
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12. Managing topology
This section contains basic information about topology in PT ISIM freeView Sensor and provides
instructions on how to manage network nodes and connections.

In this section
About topology (see Section 12.1)

Authorizing nodes (see Section 12.2)

Authorizing connections (see Section 12.3)

Changing node settings (see Section 12.4)

Merging nodes (see Section 12.5)

Adding nodes to groups (see Section 12.6)

Viewing topology in history mode (see Section 12.7)

12.1. About topology
A topology is a model that describes the composition of an enterprise computer network—nodes
and interactions between nodes at the network and data link layers.

Nodes and connections discovered in analyzed traffic are automatically displayed on the Topology
page. On this page, you can also group nodes, merge nodes into a single node, split a node with
several network interfaces into independent nodes, and authorize connections between nodes.

Node interaction cardSearching for a node Groups of nodes

Figure 25. Topology page
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A node is an element of an enterprise network interacting with other network elements. PT ISIM
freeView Sensor shows the following nodes in a topology:

– Local network nodes (that is, nodes whose IP addresses are within the range 192.168/16,
172.16/12, or 10/8) that are sources of requests or recipients responding to requests.

– External network nodes that are sources of requests.

PT ISIM freeView Sensor does not display nodes that are destinations of multicast or broadcast
packets.

An interaction link is a visual representation of interaction between nodes at the network or data
link layer. PT ISIM freeView Sensor displays interaction links if both nodes are displayed (packet
source and recipient).

Note. If nodes are addressed only at the data link layer, PT ISIM freeView Sensor does not
display nodes that are recipients of multicast traffic—that is, packets sent to the MAC address
FF-FF-FF-FF-FF-FF or to a MAC address starting with 01. Interaction links are not displayed for
such traffic.

Clicking a node displays its card on the right side of the page with the following information:

– Node settings: name, type, manufacturer, description, authorization (see Section 12.2) state.

– Time of the most recent network activity (if at least one connection is displayed for the
node).

– Network interfaces of the node.

– Ports on which node interactions took place in the last 15 minutes.

– Attacks detected on the node.
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Figure 26. Node card

PT ISIM freeView Sensor automatically identifies the node manufacturer based on the MAC
address of the node. If a node has several interfaces from different manufacturers, the node
manufacturer is displayed as "Unknown".

PT ISIM freeView Sensor automatically identifies the node type based on a number of
characteristics: manufacturer, protocol, port of the message source or recipient. For example, if the
port of a message source is 9100 or 515 or if the node manufacturer produces printers, the node
type is automatically identified as printer.

You can group nodes (see Section 12.6), for example, if they share a property, are of the same type,
or belong to the same network segment.

Clicking an interaction link between nodes displays an interaction card on the right side of the page
with the following information:

– Names of the nodes that participate in the network exchange (or their IP addresses if names
are not set).

– Incidents of the attack (see Appendix B) type that are "open" or "in progress", detected in the
traffic between these nodes.

– Diagram of events for the last 15 minutes.

– Connections between the nodes (see Section 12.3) over an application-layer protocol (or a
transport-layer protocol if an application-layer protocol is not identified).

The computer network map is updated when data on nodes and connections changes. To view its
state for a past point in time, you can use history mode (see Section 12.7).
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See also
Topology colors (see Appendix A)

12.2. Authorizing nodes
When PT ISIM freeView Sensor discovers a previously unknown MAC or IP address in traffic,
"Unauthorized node" and "Unauthorized <protocol name> connection" incidents are created on the
Incidents page and a new unauthorized node appears on the Topology page.

Note. If learning mode (see Section 8.2) is turned on, such incidents are not created, and all
discovered nodes are considered authorized.

If you consider interaction between a discovered node and nodes of an analyzed network
acceptable, you can authorize the node. If the node is also a source of an "Unauthorized node"
incident, such an incident will be closed automatically.

► To authorize a node:

1. On the Topology page, select a node.

2. In the node card that opens, click .

3. Enable the Authorized switch.

4. Click Apply.

The node is now authorized. The node color depends on the state of incidents detected on the
node (see Appendix A).

12.3. Authorizing connections
A connection is a process of data transfer from a source node to a recipient node over a certain
protocol. A single interaction may include several connections.

PT ISIM freeView Sensor considers every new connection as an "Unauthorized <protocol name>
connection" incident (if learning mode (see Section 8.2) is not turned on). If you consider a
connection acceptable, you can authorize it.

► To authorize a connection:

1. On the Topology page, select an interaction link between nodes.

This opens an interaction card on the right side of the page.
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Figure 27. Node interaction card

2. To the right of the connection, click .

3. Authorize the connection.

The connection is now authorized. PT ISIM freeView Sensor will no longer consider such
interactions as incidents. If a connection is established over a different protocol or the
source or recipient address changes, PT ISIM freeView Sensor will consider it as a new
connection and detect an incident.

12.4. Changing node settings
When a node is discovered, PT ISIM freeView Sensor displays its IP and MAC addresses in the
topology. By default, a node name is not set, and the IP address of the node is used as its ID in the
topology. The type of the new node is identified automatically based on the node manufacturer,
ports and protocol in use (see Section 12.1). You can change the node settings: select a different
node type, set a node name to display in the topology instead of an IP address, and a description.

► To change the name, type, or description of a node:

1. On the Topology page, select the node.

2. In the node card that opens, click .

3. Change the node settings: name, type, or description.

4. Click Apply.

Your changes are displayed in the topology.
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Figure 28. Changing node settings

Changing the type of a node changes how it is displayed in the topology (see Appendix C).

12.5. Merging nodes
While processing traffic, PT ISIM freeView Sensor automatically creates a new node in the topology
for each MAC address discovered during network exchange. If such MAC addresses are different
network interfaces of the same node rather than separate nodes, you can merge such nodes into a
single node with several network interfaces (equal to the number of interfaces of the nodes to be
merged).

► To merge nodes into a single node:

1. On the Topology page, select a node.

2. Hold down CTRL and select the nodes.

3. On the right side of the page, click Merge nodes.

4. In the window that opens, select the node whose settings (name, type, description, and
authorization state) will be used as settings of the merged node.
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Figure 29. Selecting settings of a merged node

A single node is displayed in the topology instead of the selected nodes. The single node will
consolidate network interfaces and incidents of the nodes that were merged.

Figure 30. Node with three network interfaces

If you want to split a node with several interfaces into independent nodes, you can click  next to
the network interface that must be used as an independent node. In the topology, the new node will
be added to the right of the node from which it was separated, and will inherit its name, type,
description, and authorization state.

12.6. Adding nodes to groups
For convenient identification of nodes in a topology, you can group them.
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► To group nodes:

1. On the Topology page, select a node.

2. Do one of the following:

• If you want to add the nodes to an existing group, select the group.

• If you want to add the nodes to a new group, click  and select the created group.

The group card opens.

Figure 31. Group card

3. Click Add nodes.

4. In the Add nodes window, enter the start and end IP addresses of the range of the nodes to
be added. If the nodes within the specified range belong to other groups and you want to
move them to the new group, enable the Move nodes from other groups switch.
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Figure 32. Grouping nodes

5. Click Apply.

To collapse a group and show only its name, you can click . To expand a group and show all
nodes included in it, you can click . If a group is collapsed, clicking the link between groups
displays a list of interactions between the nodes in these groups.

Figure 33. Interactions between grouped nodes
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12.7. Viewing topology in history mode
PT ISIM freeView Sensor allows viewing a topology in history mode in which node and connection
parameters as well as incidents and events detected on them are displayed for a selected point in
time. By switching between dates, hours, or minutes, you can track the history of discovering new
nodes and connections, incident detection, and changes in their state. In history mode, you cannot
change node and connection parameters or create groups of nodes.

► To view a topology in history mode:

1. On the Topology page, click History mode.

2. In the date and time boxes, select a point in time for which you want the topology to be
displayed.

The topology for the selected point in time is displayed. Data for this point in time is also
displayed in node and connection cards.

Note. Only the dates for which data exists in the topology are available.

Figure 34. Selecting a point in time for displaying the topology

If the topology contains no data for the selected point in time (for example, data was deleted from
the disk or a future point in time is selected), an error message is displayed with the nearest time
for which data is available specified.

You can leave history mode by clicking  in the top right or clicking History mode again.

Note. If you export a list of nodes in CSV format in history mode, the exported file also contains
data for the selected point in time.
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13. Managing events
This section contains basic information about events in PT ISIM freeView Sensor and provides
instructions on how to manage them.

In this section
About events (see Section 13.1)

Configuring display of event list (see Section 13.2)

Updating event list (see Section 13.3)

13.1. About events
An event is an instance of data transfer in a network detected by PT ISIM freeView Sensor.

PT ISIM freeView Sensor records events and their attributes: detection date and time, data on the
interaction protocol, source and target addresses, and others. Based on events, PT ISIM freeView
Sensor creates records of incidents.

Events are listed on the Events page by detection time from the newest to the oldest ones. Clicking
an event displays its card on the right side of the page.

Figure 35. List of events

13.2. Configuring display of event list
PT ISIM freeView Sensor allows filtering events—that is, configure the display of events that match
a certain criterion. This section contains instructions on how to use filtering.

In this section
Filtering events by attribute (see Section 13.2.1)

Filtering events by time (see Section 13.2.2)
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13.2.1. Filtering events by attribute
Filtering by attribute allows you to configure the display of events that match a certain criterion, for
example, have the same protocol or source address.

► To filter events by attribute:

1. In the filter panel, select one or several attributes and their values.

If you want to filter events by a protocol, IP or MAC address already present in the list of
events, you can select the necessary value to add it to the filter panel.

2. Click Apply.

Figure 36. Filtering events by attribute

Only the events that have the selected attribute value will be displayed in the list.

► To clear the applied filter,

Click Clear in the lower part of the filter panel.

13.2.2. Filtering events by time
Filtering by time allows you to configure the display of events that were detected for a certain
period.

► To filter events using the timeline,

Select a time range on the timeline while holding down the left mouse button.

Events for the selected period will be displayed in the list.
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Figure 37. Selecting a time range on the timeline

► To filter events for certain dates:

1. Click  in the right part of the timeline.

2. Select a time range in the calendar or specify its beginning and end in the boxes.

3. Click Apply.

Events for the selected dates will be displayed in the list.

Figure 38. Selecting a time range in the calendar

13.3. Updating event list
If, while the Events page is open, PT ISIM freeView Sensor detects new events, you can refresh the
list of events so that the new events are displayed.

► To refresh the list of events,

Click Load new events above the list of events.
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14. Managing timeline notes
PT ISIM freeView Sensor allows adding notes to the timeline to describe the state of the analyzed
system at a certain point in time, mark the beginning or end of an event (for example, repair works
at the technological facility). Such notes can later help understand why the behavior of PT ISIM
freeView Sensor or the ICS changed.

In this section
Creating notes (see Section 14.1)

Deleting notes (see Section 14.2)

14.1. Creating notes
► To add a note to the timeline:

1. Select a time range on the timeline.

2. In the window that opens, click Add note.

This opens a new note window.

3. Enter a note and click Save note.

You can use the switches at the top of the window to change the note color in oder to
distinguish it from other notes on the timeline.

Figure 39. Creating a note

You can have several messages within a single note.

14.2. Deleting notes
► To delete a note:

1. Select the note on the timeline.

The note window opens.

2. Click .

3. In the window that opens, confirm that you want to delete the note.
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15. Exporting list of events, incidents, and nodes
You can export lists of incidents, events, and nodes as CSV files. Events and incidents are exported
as a CSV file taking account of an applied filter.

► To download a list of events,

On the Events page, click Download events.

The exported list of events contains the date and time of an event, its class, protocol, name or IP
address of the source and recipient node. The number of events in a CSV file is limited to 1,000.

► To download a list of incidents in CSV format,

On the Incidents page, click Download incidents.

The exported list of incidents contains the IP and MAC address of the source and target of an
incident, the state, type, ID, start and end time of an incident. For a suspended warning, the time
when such an incident will be reopened is displayed.

► To download a list of nodes in CSV format,

On the Topology page, click Download topology.

The exported list of nodes contains the name of a node, the manufacturer, addresses of network
interfaces, time of the most recent network activity, state, type, and ID. If a node has several
network interfaces, each of the interfaces is exported as a separate string in the CSV file.

Note. Cyrillic characters in the CSV file may be incorrectly displayed in Microsoft Excel. In this
case, you must reopen the file and select the UTF-8 encoding. For this, in Microsoft Excel, in the
Data → Get External Data tab, click From Text, select the CSV file, and in the window that opens,
in the File origin drop-down list, select UTF-8.
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16. Diagnosing PT ISIM freeView Sensor
In the PT ISIM freeView Sensor web interface, you can diagnose the product and the server on
which it is installed. The following is available for diagnostics:

– State of network interfaces

– State of services (with log files for each service available for viewing)

– Hard drive space, amount of dedicated RAM, network connection to the Internet

In this section
Viewing state of network interfaces (see Section 16.1)

Viewing state of services and basic system parameters (see Section 16.2)

Viewing service logs (see Section 16.3)

Downloading diagnostic information package (see Section 16.4)

16.1. Viewing state of network interfaces
► To view the state of network interfaces,

On the toolbar, click .

This opens a window that shows whether there is a connection to network interfaces, and
displays the average packet transfer rate and the number of packets for the last 15 seconds
and 30 minutes.

Figure 40. Viewing the state of network interfaces

Network interfaces from which industrial network traffic must be captured, must be bonded into
the bond0 virtual interface.

Note. If network interfaces must be reconfigured after the product is installed, you can open the
interface configuration window by running the isim net command.
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16.2. Viewing state of services and basic system parameters
► To view the state of services and basic system parameters,

On the toolbar, click , and on the menu that opens, click Run diagnostics.

This opens the Diagnostics window that allows viewing the following system parameters:

– State of services:

• ОК, if a service is running.

• Error, if a service is not running.

Note. You can restart a service by running the following command:
systemctl restart <name of service in command line>

• Request error, if an error occurred while requesting the state of a service (see Section
17.5).

Table 4. PT ISIM freeView Sensor services

Name of the service in the web interface Name of the service in the command line

ARP analysis service arpwatch.service

Event storage service clickhouse-server.service

DPI Broker Server service ptdpi-broker-srv.service

PT DPI Broker service ptdpi-broker.service

PT DPI Networking service ptdpi-networking.service

DPI service ptdpi.service

PT Artifacts service ptisim-artifacts.service

PT DPI Broker Worker service ptisim-broker-worker.service

Traffic analysis service ptisim-core.service

HTTP API service ptisim-httpapi.service

Incident recording service ptisim-incident-listener.service

Modeling service ptisim-model-service-ng.service

PT Peony service ptisim-peony.service

Monitoring backend service ptisim-redis-server-monsto.service

Data receiver service ptisim-rester.service

Message exchange service rabbitmq-server.service

Active list service redis-server.service

– bond0 carrier status shows that the bond interface is configured and traffic is received on it.
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You can view detailed information about each of the parameters by clicking their names or .

16.3. Viewing service logs
► To view a service log:

1. On the toolbar, click , and on the menu that opens, click Run diagnostics.

2. Click the name of the service, and on the menu that opens, click Show log.

This opens a window with a log of the selected service.

The interval for which a log is displayed depends on log rotation settings.

16.4. Downloading diagnostic information package
A diagnostic information package is a set of files that allow diagnosing the product and the server
on which it is installed. A diagnostic information package contains log files and configuration files
for PT ISIM freeView Sensor components, information about the state of services, versions of
components, and basic parameters of the server—amount of RAM and disk space.

► To download a diagnostic information package:

1. On the toolbar, click , and on the menu that opens, click Run diagnostics.

2. In the lower part of the Diagnostics window, click Download diagnostic information
package.

The archive download begins.

Note. If the PT ISIM freeView Sensor web interface is unavailable, you can download a
diagnostic information package by entering <product IP address>/logs in the browser
address bar.
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17. Troubleshooting
This section contains troubleshooting tips for PT ISIM freeView Sensor.

In this section
Problems while starting virtual machine (see Section 17.1)

Recovering password for logging in to web interface (see Section 17.2)

Problems detecting network nodes (see Section 17.3)

No events in web interface (see Section 17.4)

No data in Diagnostics section (see Section 17.5)

Network interface setup errors (see Section 17.6)

17.1. Problems while starting virtual machine
After the PT ISIM freeView Sensor OVA image is imported, errors may occur while attempting to
start the virtual machine. As a rule, they are caused by the virtual machine configuration requiring
more resources than the host machine can allocate, or (if Oracle VM VirtualBox is used) the
hypervisor incorrectly identifying the image bitness.

If a hypervisor that does not allow selecting the imported image configuration is used (VMware
Workstation earlier than version 14 or Oracle VM VirtualBox), the maximum configuration is
selected automatically: "8 CPUs and 16384 MB RAM. Normal-performance configuration."
Manually changing the virtual machine configuration is recommended for evaluation and testing
purposes only. To use all the functions of PT ISIM freeView Sensor, it is recommended to use the
maximum configuration.

Table 5. Problems while starting the virtual machine

Problem Possible cause Solution

Error "Powering on the vir-
tual machine will fail be-
cause it is configured to
use more virtual processor
cores than the host sup-
ports." or similar

The host machine cannot al-
locate enough resources to
the OVA image

Reduce the number of cores in
the virtual machine settings

Black screen while starting
the virtual machine in Ora-
cle VM VirtualBox

The hypervisor incorrectly
identified the virtual ma-
chine bitness or you incor-
rectly specified it when im-
porting the OVA image (see
Section 7.3).

In the virtual machine settings, on
the General tab, select Debian
(64-bit) for the Version setting. If
this option is unavailable, check
the host machine settings: hard-
ware virtualization may be turned
off
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17.2. Recovering password for logging in to web interface
When you first log in to PT ISIM freeView Sensor web interface, you set the user account password
(see Section 8.1) for accessing the web interface of the product.

If you forget your password, you can set a new password.

► To set a new password:

1. In the command line interface of the virtual machine on which PT ISIM freeView Sensor is
installed, run the following command:
isim uipass

2. Enter a new password.

3. Press y to confirm the password change.

The password is now changed. You can log in to the PT ISIM freeView Sensor web interface
using your new password.

17.3. Problems detecting network nodes

Problem
New network nodes are not displayed on the Topology page of the PT ISIM freeView Sensor web
interface.

Possible causes
– The ptisim-model-service-ng, arpwatch, ptisim-httpapi services do not work.

– PT ISIM freeView Sensor does not detect events.

Solution

► To solve the problem:

1. Check the status of the ptisim-model-service-ng, arpwatch, ptisim-httpapi services:
sudo systemctl status ptisim-model-service-ng arpwatch ptisim-httpapi

The status of each service must be Active: active (running).

2. If the status of a service differs, restart it:
sudo systemctl restart <service name>

3. If the services are running but no nodes appear on the Topology page, check that events
exist.
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17.4. No events in web interface

Problem
No events are displayed in the PT ISIM freeView Sensor web interface.

Possible causes
To identify what causes the problem and how to solve it, you must make sure that events exist in
the database.

► To check that events are present in the database,

Run the following command:
echo "select toDateTime(time), count() from isim.events group by time, class order by time
DESC" | clickhouse-client -n

This displays data on the number of events grouped by time.

Solution
If events for a certain period exist in the database but are not displayed in the web interface, you
must check the ptisim-httpapi service and restart it if its status differs from Active: active
(running).

If events for a selected period do not exist in the database, try creating test events (see Section
8.3). If test events do not appear in the database and the web interface either, the solution of the
problem may include several stages.

Stage 1. Checking the time zone
Check the following time settings:

– The UTC time zone must be set on the PT ISIM freeView Sensor server.

– The time zone of the browser that you use to access the PT ISIM freeView Sensor web
interface must correspond to your real UTC time zone. Example: if your time zone is UTC+2,
the time zone of your browser must also be UTC+2.

Stage 2. Checking the status of services
Check the status of services. All services must be running (have the "OK" status).

If all services are running but events are still not displayed in the PT ISIM freeView Sensor interface,
go to Stage 3.
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Stage 3. Checking the presence of network traffic

► To check that traffic is present in the network:

1. Run the following command:
sudo tcpdump -nli bond0

2. If no traffic is detected on the bond0 interface, check that traffic is present on the interfaces
from which industrial network traffic must be captured:
sudo tcpdump -nli <network interface name>

Note. You can also check the status of network interfaces via the web interface (see Section
16.1).

3. If no traffic is detected on the specified interfaces, check the connection to the switch from
which traffic must be captured, and make sure that the network cable is connected and
functions properly.

4. If traffic is detected on the specified interfaces but is not detected on the bond0 interface,
go to Stage 4.

Stage 4. Setting up network interfaces
Network interfaces from which industrial network traffic must be captured, must be bonded into
the bond0 virtual interface.

Network interfaces are set up, which includes their bonding into bond0, during the system
installation.

To check the settings of network interfaces,

Run the following command:
sudo ip addr show

It must be specified in the command output that the bond0 virtual interface is turned on (UP
BROADCAST RUNNING MASTER) and network interfaces from which industrial network traffic
must be captured are turned on and bonded into bond0 (UP BROADCAST RUNNING SLAVE)

► To bond network interfaces into bond0:

1. Invoke the network interface setup tool by running the following command:
isim net

This opens the Interface list window containing a list of network interfaces.

If a network cable is connected to the interface, the Cable connected column contains Yes.

Note. If you disconnected or connected a cable, you must refresh the status of interfaces by
selecting one of the interfaces and returning to the Interface list window by selecting Exit.

2. Select the network interface from which industrial network traffic must be captured, and
press ENTER.

3. Select Add to bond and press ENTER.
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4. In the Interface list window that opens, select Save and press ENTER.

5. Check the state of network interfaces.

6. Check that events are present in the PT ISIM freeView Sensor web interface.

See also
Viewing state of services and basic system parameters (see Section 16.2)

17.5. No data in Diagnostics section

Problem
Request error is displayed on the Diagnostics page of the PT ISIM freeView Sensor web interface.

Possible causes
The ptisim-httpapi service does not work.

Solution

► To solve the problem:

Restart the ptisim-httpapi service:

sudo systemctl restart ptisim-httpapi.service.

After the service is restarted, its status must be Active: active (running).

You can check the status of the service by running the following command:
systemctl status ptisim-httpapi.service.

17.6. Network interface setup errors
PT ISIM freeView Sensor contains a script for interactive setup of network interfaces. The script
retrieves a list of network interfaces that must be set up from the file /etc/network/interfaces.
If the file contains incorrect parameters, errors may occur after the script is started.

Table 6. Network interface setup errors

Error text Cause Example of incorrect
settings

Example of correct
settings

Startup of
non-config-
ured inter-
face

The auto
string con-
tains an inter-
face for which
no parameters
are specified

auto eth0

iface eth1 inet dhcp

auto eth0

iface eth0 inet dhcp

Troubleshooting

63



Error text Cause Example of incorrect
settings

Example of correct
settings

Incorrect
stanza be-
ginning

The interface
setup string
does not be-
gin with
iface, map-
ping, auto,
allow,
source,
source-di-
rectory

face eth0 inet dhcp iface eth0 inet dhcp

Interface
name may
not start
with #

The interface
name starts
with #

iface #eth1 inet dhcp iface eth1 inet dhcp

Duplicate
declaration
of <inter-
face name>

An interface
with the same
name is de-
clared twice

auto eth2

iface eth2 inet dhcp

auto eth2

iface eth2 inet dhcp

auto eth1

iface eth1 inet dhcp

auto eth2

iface eth2 inet dhcp

bond0 is
configured
but does
not have a
"slaves"
field

The bond0 in-
terface has no
slave inter-
faces

iface bond0 inet manual iface bond0 inet manual

slaves eth1
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Appendix A. Topology colors

Node color and highlighting
The color and highlighting of a node in a topology depends on the presence of incidents of the
"attack" type on the node, the state of incidents, and node authorization state.

Table 7. Node colors

The node has attacks
that are not closed

The node is autho-
rized

Code Example

 Any Red node highlighted in
red

  Red node

  White node

If you search for a node by a certain criterion (name, type, IP or MAC address, network card
manufacturer), nodes that match the criterion are highlighted while nodes that do not match it are
dimmed.

Table 8. Node colors while searching a topology

The node
matches search

criteria

The node has
attacks that are

not closed

The node is
authorized

Code Example

  Any Red node highlighted in
red

   Red node highlighted in
white

   White node highlighted
in white

  Any Dimmed red node high-
lighted in red
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The node
matches search

criteria

The node has
attacks that are

not closed

The node is
authorized

Code Example

   Dimmed red node

   Dimmed white node

Interaction link color
The color of an interaction link depends on the state of incidents detected in the traffic between
nodes. The transparency of an interaction link depends on the state of incidents and the detection
time of last incidents in the traffic between nodes.

Table 9. Interaction link colors

Code Code

Color Green The interaction has no "open" or "in progress" incidents of the
"attack" type

Red The interaction has at least one "open" or "in progress" incident
of the "attack" type

Trans-
parency

Non-trans-
parent

At least one event was detected between the nodes in the last 15
minutes

Half-trans-
parent

At least one event was detected between the nodes in the last 24
hours excluding the last 15 minutes

Two-thirds
transparent

At least one event was detected between the nodes before the
last 24 hours, and the interaction has at least one "open" or "in
progress" incident of the "attack" type

If an interaction has no allowed connections and no "open" or "in progress" incidents of the "attack"
type, the interaction link disappears 24 hours after the last event is detected.
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Appendix B. Incident types
PT ISIM freeView Sensor classifies incidents into the following types: attacks, warnings, and
system incidents.

Attacks
Attacks are incidents caused by targeted action by a malicious user.

Table 10. Attacks

Attack type Attack subtype Realization protocol

Obtaining access Credential bruteforcing HTTP, S7, Telnet

Access to the management
interface

DHCP, HTTP

Impact on the industrial
network

Unauthorized node All supported protocols

Unauthorized connection All supported protocols

Attempt to establish a con-
nection

MMS, IEC 104

Fake server DNS, DHCP, FTP, TFTP

Obtaining critical information TLS, CIP

Unauthorized change of de-
vice settings or mode

CIP, DHCP, HTTP, SNMP, MMS,
OPC DA, Profinet-DCP, S7, SPABus

DoS CIP, DHCP, ICMP, Modbus,
Profinet-DCP

Warnings
Warnings are incidents indicating invalid message formats of a protocol, failure to comply with
security policy requirements, or actions that may be classified as preparation for a targeted attack.

Table 11. Warnings

Warning type Protocol

Use of weak passwords FTP, HTTP, SNMP, Telnet

Use of an insecure protocol version SSH

Use of an insecure protocol Telnet

Node does not respond to requests ARP

Network scan TCP, S7, CIP, ICMP

Change of device settings, mode, state CIP, S7, SNMP
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Warning type Protocol

Request, operation error MMS, CIP, Modbus

Invalid data format/set in a packet CIP, IEC104, MMS, Modbus

System incidents
System incidents record important changes in PT ISIM freeView Sensor state and potentially
harmful actions against the product. System incidents also include "PT ISIM test incident" used for
testing purposes (see Section 8.3).

Table 12. System incidents

Incident name Condition

PT ISIM web interface brute-force attack over
HTTP

Five or more unsuccessful attempts to log in
to the PT ISIM freeView Sensor web interface
within 10 minutes

PT ISIM server brute-force attack over SSH Five or more unsuccessful attempts to con-
nect to the PT ISIM freeView Sensor server
over SSH within 10 minutes

PT ISIM freeView Sensor Reboot Any PT ISIM freeView Sensor server restart

Forced data deletion PT ISIM freeView Sensor starts deleting log
files, events, network model copies to main-
tain the necessary minimum amount of free
disk space. The minimum amount is set by the
product administrator (20 percent by default)

Learning mode is enabled Learning mode (see Section 8.2) is turned on

PT ISIM test incident 100-byte ICMP packet to the multicast ad-
dress 224.0.0.42

Possible disconnection of PT ISIM No traffic on the bond0 interface for 15 min-
utes or longer

Insufficient system resources The parameters of the system on which
PT ISIM freeView Sensor is installed are lower
than the minimum configuration (see Section
5)
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Appendix C. Node types
The following table contains a list of node types in a topology: their graphics on the Topology page
and names of types in an exported CSV file (see Section 15).

Table 13. Node types

Graphic on the Topology page Node type Name of the type in CSV

Unknown Unknown

HMI HMI

HMI Panel PANEL

Converter NPORT

SCADA server SCADA

Protective relay DPR

PLC PLC

GPS time server GPS

UPS UPS

Generic network device GENERIC
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Graphic on the Topology page Node type Name of the type in CSV

Sensor SENSOR

Switch SWITCH

Modem MODEM

Printer PRINTER

Workstation PC

Data historian ARCHIVER

OPC server OPC
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Positive Technologies is a leading global provider of enterprise security solutions for vulnerability and
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